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Introduction

Welcome to the Introduction to Mastercam tutorial. This tutorial is geared to help you 
explore some of Mastercam’s interface and to learn basic concepts of the software. 
The tutorial includes the following:

 A broad look at the Mastercam interface, including the ribbon interface, Quick 
Access Toolbar (QAT), Selection Bar, Quick Masks, Status Bar, and Managers. 

 An introduction to Mastercam’s File menu, also known as the Backstage, 
where you manage and print files, alter System Configuration, customize the 
interface using Options, and access Help, Tutorials, and other Mastercam 
Community resources.

 An overview of Mastercam’s graphics window using viewing options, and 
introducing levels and planes.

Tutorial Goals
 Gain an understanding of some of Mastercam’s functions.
 Set up a configuration file and customize Mastercam’s interface to suit your 

working style.
 Manipulate Mastercam’s graphics window, levels, and planes to view your 

part.

Estimated time to complete this tutorial: 5.00 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 The tutorials cannot be used with Mastercam Demo/Home Learning Edition 

(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file 
format (mcam), and basic Mastercam functions, such as file conversions and 
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 
We recommend that you complete them in order. 
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 Additional files may accompany a tutorial. Unless the tutorial provides specific 
instructions on where to place these files, store them in a folder that can be 
accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.

 All Mastercam tutorials require you to configure Mastercam to work in a 
default metric or English configuration. The tutorial provides instructions for 
loading the appropriate configuration file.

IMPORTANT: Screen colors in the tutorial pictures may have been 
modified to enhance image quality; they may not match your 
Mastercam settings or the tutorial results. Color difference do not affect 
the lessons.
INTRODUCTION TO MASTERCAM



LESSON 1
1Mastercam Interface Overview

Mastercam’s ribbon interface is based on standard Windows design guidelines. The 
ribbon is composed of familiar controls including a quick access toolbar (QAT), tabs, 
contextual tab groups, galleries, buttons, and the Backstage. It also features special 
on-screen controls, and movable, dockable Managers.

This section briefly touches on the elements that make up the Mastercam interface to 
give you a better understanding of how to use these elements to create and machine 
your parts.

Exploring Mastercam’s Interface
 Start Mastercam by either:
 Double-clicking Mastercam’s 

desktop icon.
Or

 Launching Mastercam from 
the Windows Start menu.

Take a few moments to explore Mastercam’s interface.

The following image indicates the elements that make up the Mastercam 
interface. The corresponding sections provide brief descriptions of each 
element and its use. 
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1 Quick Access Toolbar (QAT) A customizable set of commonly used functions 
that are always available in the interface. The QAT can be located above or 
below the ribbon.

2 Tab Groupings of related controls. Tabs are organized in a simple-to-complex 
workflow from left to right.

3 Tab Group A region of the tab that contains a set of related controls.

4 Contextual Tab A tab that displays when you make a specific selection in 
Mastercam. A contextual tab presents relevant controls and commands to 
your current activity.

5 Tooltip A small window with descriptive text that automatically displays when 
you hover over a command or control.

6 Selection Bar A toolbar which combines AutoCursor controls and general 
selection tools used to select entities in the graphics window. There are two 
selection modes, Standard Selection and Solid Selection, which are activated 
based on the function you are using. AutoCursor controls allow you to detect 
INTRODUCTION TO MASTERCAM
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and snap to points as you move the cursor over geometry in the graphics 
window. AutoCursor becomes active whenever Mastercam prompts you to 
select a position in the graphics window. 

7 Quick Masks A group of controls 
that helps you to select all entities of 
a certain type, or to select only 
entities of certain type. Most 
controls are divided in half. Clicking 
the left or right side of the control 
toggles between selection modes. 

When a Quick Mask control is 
selected it lights to indicate the 
selection mask is on. You can toggle 
multiple Quick Masks at a time. 

8 Status Bar A bar across the bottom of the workspace that shows the 
coordinate position of the cursor and provides quick access to modify the 
Cplane, Tplane, WCS, and Z Depth of geometry and toolpaths in the graphics 
window. The right side of the Status bar has Wireframe, Shaded, and 
Translucency controls that change the appearance of your part.

Standard Selection

Solid Selection
INTRODUCTION TO MASTERCAM
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9 Dynamic Gnomon The on-screen 
gnomon allows you to manipulate 
geometry and planes interactively. 
The gnomon comprises three axes 
connected at the origin, with 
selection points that let you choose 
different types of transformations.

10 Managers Managers include 
controls for toolpaths, solids, planes, 
levels, recent functions, and Art. The 
Managers can be stacked, docked, 
or floating. 

 Toolpaths Manager: Lists the 
toolpath groups and machine 
types for the current file. Use 
the Toolpaths Manager to 
generate, sort, edit, 
regenerate, and post 
operations.
INTRODUCTION TO MASTERCAM
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 Solids Manager: Lists each 
solid in the current file along 
with its operation history and 
associated toolpaths. Use the 
Solids Manager to edit solids 
and their operations.

 Planes Manager: Shows the 
planes in the current file. Use 
the Planes Manager to 
display, create, edit, select, 
and manage planes and work 
offsets.
INTRODUCTION TO MASTERCAM
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 Levels Manager: Shows the 
levels in the current file. Use 
the Levels Manager to create, 
select, hide or show levels, 
and set the active level.

 Recent Functions: Provides 
quick access to recently used 
functions.
INTRODUCTION TO MASTERCAM
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 Art Manager: Manages the 
elements of the current Art 
model. (Only available if 
Mastercam Art is installed.)

11 Graphics window The workspace in which you view, create, and modify your 
parts. The graphics window also displays information about the current 
measurement system (inches or millimeters), and the coordinate axes for the 
current view or plane.

Common Interface Controls
The following table shows common controls used in the Mastercam interface. The 
icons may vary slightly depending on their location in Mastercam. 

OK and Create New Cancel

OK/Save Help

Apply About Mastercam
INTRODUCTION TO MASTERCAM
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Lesson Goals
 Customize the Quick Access Toolbar.
 Explore the ribbon interface.
 Configure System Attributes.
 Understand Selection Bar, AutoCursor and Fast Point.
 Use Quick Masks.
 Explore the Status Bar.

Exercise 1-1: Customizing the Quick Access Toolbar
The Quick Access Toolbar (QAT) is a collection of frequently used functions. The QAT 
is always available and can be displayed above or below the ribbon. You can easily add 
or remove functions from the QAT.

In this exercise you will move and customize the QAT.

1 Click the QAT drop-down and select 
Show Below the Ribbon. 

The QAT displays between the 
ribbon and the managers.

2 Click the QAT drop-down again and 
select More Commands.

The Options dialog box opens.
INTRODUCTION TO MASTERCAM
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3 On the Quick Access Toolbar page 
select View from the Choose 
commands from drop-down.

4 Select Fit in the Commands list and then click Add.

5 Click OK and the Fit command 
shows in the QAT.

6 Alternately, you can add any 
command in the ribbon to the QAT 
by right-clicking the command in 
the ribbon and selecting Add to 
Quick Access Toolbar.

7 Return the QAT to its placement above the ribbon.

Exercise 1-2: Exploring the Ribbon Interface
The ribbon interface consists of multiple tabs that group together related functions 
and controls. Tabs are typically organized in a simple-to-complex workflow from left to 
right. Some tabs are contextual and only display when needed in the workflow. For 
INTRODUCTION TO MASTERCAM
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instance, you must select a machine before the contextual toolpath tab displays on the 
ribbon.

Click each tab to open it, or left click the ribbon and then use the scroll wheel on your 
mouse to move through the tabs.

In this exercise you will manipulate the ribbon tabs.

1 Right-click the ribbon and select                  
Minimize the Ribbon. 

View the maximized workspace.

2 Click any tab to display it. Click in 
the graphics window to hide the tab 
again.

3 Right-click the ribbon and deselect Minimize the Ribbon to show the tabs 
again.

4 Click the Machine tab.

5 Choose Mill, Default to select your 
machine.

NOTE: Available machine types are based on your license and may vary 
from what is shown in this tutorial. If Mill is not available, select the 
default machine for a machine type licensed to you.
INTRODUCTION TO MASTERCAM
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6 The Mill Toolpaths contextual tab 
displays.

7 Click the Expand gallery arrow in the 3D group. The related toolpaths 
display. 

8 Click the Machine tab again and select Router, Default. Explore the Router 
Toolpath contextual tab. If Router is not available, select a different machine 
type that is licensed to you.

9 Continue to select different machines and view the related toolpaths tabs.

Exercise 1-3: Customizing the Ribbon
You can create a new ribbon tab and customize it with functions of your choice. In this 
exercise you will create a new tab, add several functions, and change the tab’s position 
on the ribbon.

1 Right-click the ribbon and select 
Customize the Ribbon.

The Options dialog box opens.
INTRODUCTION TO MASTERCAM
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2 Select the View tab in the Customize the Ribbon list as shown in the 
following illustration.

3 Click New Tab. The New Tab 
(Custom) and New Group 
(Custom) appear at the bottom of 
the Main Tabs list. 

4 Select New Tab (Custom) and then 
click Rename. Alternately, you can 
right-click New Tab and select 
Rename from the context menu.
INTRODUCTION TO MASTERCAM
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5 Enter My Tab for the Display Name 
and click OK.

6 Select New Group (Custom) in the list of tabs and click Rename. 

7 Enter My Group for the Display 
Name and click OK.

8 Select Pan geometry from the Commands Not in the Ribbon list and then 
click Add.

The command is added to My 
Group (Custom).
INTRODUCTION TO MASTERCAM
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9 Select Zoom On Target from the 
Commands Not in the Ribbon list 
and then click Add.

The command is added to My 
Group (Custom).

10 Select My Tab (Custom) and use 
the up arrow button to position the 
tab below the Home tab.

11 Click OK to close the Options dialog box.

12 Choose My Tab to view your 
customized tab with the Pan and 
Zoom Target commands.

13 On your own, return to the Options dialog box to add more commands to 
your tab, or rearrange the order of the ribbon tabs.

Exercise 1-4: Setting System Attributes for the Current File
System attributes control point and line styles as well as colors associated with types 
of entities you create in Mastercam. You can change the attributes of selected entities 
INTRODUCTION TO MASTERCAM



SETTING SYSTEM ATTRIBUTES FOR THE CURRENT FILE   23
in the graphics window using the controls on the Home tab or from the right-click 
mini-toolbar (shown below). 

When nothing is selected in the graphics window, you can also set system attributes 
for the current file using these controls. Alternately, set system attributes that persist 
between sessions using the Color and CAD Settings pages of the System Configuration 
dialog box. 

In this exercise you will use the attributes controls located on the mini-toolbar, which 
is accessed by right-clicking in the graphics window.

1 Right-click the graphics window to 
open the mini-toolbar and context 
menu.

2 Click the last button (shown in the previous illustration), to pop off the mini-
toolbar. You can resize and position the mini-toolbar anywhere in the 
graphics window.
INTRODUCTION TO MASTERCAM
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3 With nothing selected in the 
graphics window, click the Line 
Style drop-down and choose the 
style shown to the right. 

New geometry you create will use 
the chosen line style.

4 Select the Line Width shown to the 
right. 

New geometry you create will use 
the chosen line width.

5 Click the Wireframe Color drop-
down and select green as shown to 
the right.

6 On the Wireframe tab, choose 
Rectangle. 

The Rectangle function panel opens.
INTRODUCTION TO MASTERCAM
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7 Click in the graphics window and 
draw two rectangles of any size. 
(Follow the prompts shown in the 
upper left corner of the graphics 
window.) 

8 Click OK to close the Rectangle 
function panel. 

The rectangles are created using the 
line style, width, and color you 
previously selected in this 
procedure. 

Your rectangles may vary from the 
examples shown to the right.

9 Window select one rectangle in the 
graphics window.

10 Click the Wireframe Color drop-
down and select purple.
INTRODUCTION TO MASTERCAM
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Only the rectangle you selected changes to purple as shown in the following 
illustration. 

11 Notice that the default wireframe 
color has not changed on the mini-
toolbar. Any new wireframe 
geometry you create will use the 
default color, green.

12 Click the last button on the mini-
toolbar to close it.

13 With nothing selected in the 
graphics window, return the Line 
Style and Line Width to the options 
shown to the right. 

14 Return the Wireframe Color to 
standard blue shown to the right. 

15 Click File, Save. Name your file ATTRIBUTES.mcam and save it in the same 
location as the other tutorial files. 
INTRODUCTION TO MASTERCAM
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TIP: To set default system attributes that persist from session to session, 
use the System Configuration dialog box and save the settings to the 
configuration file. See Working with Configuration Files for more informa-
tion.

Exercise 1-5: Understanding the Selection Bar and AutoCursor
Selection Bar combines general selection tools used to select entities in the graphics 
window and AutoCursor controls. Selection Bar is located across the top of the 
graphics window. It has two modes, Standard Selection and Solid Selection, which are 
activated based on the function you are using. 

AutoCursor controls allow you to detect and snap to points as you move the cursor 
over geometry in the graphics window. AutoCursor becomes active whenever 
Mastercam prompts you to select a position in the graphics window.

In this exercise you will precisely locate points and lines using AutoCursor and Fast 
Point fields. 

1 If necessary open the file, 
ATTRIBUTES.mcam, that you saved 
from the previous lesson.

Your file may look slightly different 
than the one to the right.

2 Select Line Endpoints on the 
Wireframe tab. 

The Line Endpoint function panel 
opens and Mastercam prompts you 
to specify the first endpoint.
INTRODUCTION TO MASTERCAM
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3 Click the AutoCursor drop-down 
and select Midpoint. 

4 Click anywhere on the top line of 
one of your rectangles and drag up 
to draw a line. 

Mastercam automatically uses the 
midpoint of the entity that you 
selected as the first endpoint.

5 Click to set the second endpoint.

6 Choose OK in the Line Endpoints 
function panel.

7 Select Circle Center Point on the 
Wireframe tab.

The Circle Center Point function 
panel opens and Mastercam 
prompts you to enter the center 
point.

8 Select AutoCursor Fast Point on 
the Selection Bar, (or press the 
spacebar on your keyboard), to 
display the Fast Point field. You can 
enter numbers, formulas, or X,Y,Z 
coordinates. 
INTRODUCTION TO MASTERCAM
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9 Type 0,0,0 to enter the coordinate location of the circle’s center point, and 
then press [Enter].

10 Drag and click to set the radius of the circle. The center point of the circle is at 
0,0,0. 

11 Choose OK in the Circle Center Point 
function panel.

12 If the entities are outside of the graphics window, right-click and choose Fit.
13 Save your file.
INTRODUCTION TO MASTERCAM
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Exercise 1-6: Using Quick Masks
Mastercam’s Quick Masks allow you to select all entities of a specific type, or to select 
only entities of specific type. Most controls are divided in half. Clicking the left or right 
side of the control toggles between all/only selection modes. You can select multiple 
Quick Masks.

Hover over each control to view the tooltip describing its function.

In this exercise you will select entities using several Quick Mask functions.

1 If necessary click File, Open and open ATTRIBUTES.mcam, which you saved in 
the previous lesson.

2 Before beginning this lesson, click 
Clear all masking. 

3 Click Select all line entities. 

The rectangles and line that you drew in the previous exercise are selected in 
the graphics window. The circle is not selected as it is an arc. 
INTRODUCTION TO MASTERCAM
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4 Click Clear selection.

5 Choose Select only arc entities.

6 Click and drag to window select all entities in the workspace.
INTRODUCTION TO MASTERCAM



32  MASTERCAM 2017 / Mastercam Interface Overview
Only the circle is selected as shown in the following illustration.

7 Click Clear selection.

8 Choose Select all entities by color 
and the Select All dialog box opens.
INTRODUCTION TO MASTERCAM
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9 Select the blue checkbox and then 
click OK.

The Quick Masks, Select only arc 
entities and Select only wireframe 
entities remain selected from the 
previous steps and affect the 
outcome.
INTRODUCTION TO MASTERCAM
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Only the circle is selected in the workspace as it is the only arc entity that is 
blue. The blue line is not selected as shown in the following illustration.

10 Select Clear all masking before proceeding with the next lesson.

Exercise 1-7: Exploring the Status Bar
The Status Bar across the bottom of the workspace gives a visual indication of the 
position of the cursor on the workspace (X,Y,Z). It also provides quick access to the 2D/
3D switch and lets you modify the Cplane, Tplane, WCS, and Z Depth of geometry and 
toolpaths in the graphics window. The right side of the Status Bar contains Wireframe, 
Shaded, and Translucency controls.

In this lesson you will use the wireframe, shaded, and translucency controls to change 
the appearance of a part. See Help for information on other Status Bar features.

1 Open BRACE.mcam, which was 
provided with the tutorial. Choose 
Don’t Save when prompted to save 
your file from the previous lesson.

The part displays as a solid.
INTRODUCTION TO MASTERCAM
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2 Choose Wireframe on the Status Bar.

3 Choose No Hidden on the Status 
Bar.

The part displays only the wireframe 
that is visible in the current view.
INTRODUCTION TO MASTERCAM
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4 Choose Outline Shaded and 
Translucency on the Status Bar.

The part displays as a translucent 
solid. 

5 Continue to experiment with the 
appearance controls.

TIP: You can also alter how a part 
displays using the Appearance 
controls located on the View tab.

6 Click File, New. Choose Don’t save when prompted to save changes to the 
current file.

You have now completed Lesson 1 of the Introduction to Mastercam tutorial. In the 
next lesson, you learn more about the Mastercam managers.
INTRODUCTION TO MASTERCAM
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2Working with the Managers

Mastercam has several movable, dockable managers that provide flexible access to 
frequently used functions including:

 Toolpaths
 Solids
 Planes
 Levels
 Recent Functions

You can toggle the display of the managers, as well as move one or more managers to 
a new location. Dock a manager to a fixed location on the interface, float it anywhere 
on the workspace, or even move it to another monitor. Mastercam remembers the 
settings even after you close the application.

In this exercise, you use different methods to move, hide, display, and customize a 
manager.

Lesson Goals
 Dock, undock, and move a manager.
 Hide and display a manager.
 Customize a manager.
 Explore the Recent Functions Manager. 

Exercise 2-1: Moving and Docking Managers
In this exercise, you move and dock one or more managers.

1 Click the title bar of the top manager and drag the stack of managers into the 
graphics window. Drop the managers onto the blue docking icon on the right 
side of the interface. 
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All of the managers are now docked in the new location. 

2 Click the Planes tab and drag and 
drop it anywhere on the workspace. 
INTRODUCTION TO MASTERCAM
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3 Resize the Planes Manager by 
clicking and dragging any of its 
edges.

4 Double-click the Planes Manager’s 
title bar to redock it on top of the 
stack of managers.

5 Click the title bar of the stack of managers and drag it to the left side of the 
graphics window where it was docked at the beginning of this lesson.
INTRODUCTION TO MASTERCAM
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TIP: If you work with two monitors, position the managers onto the 
monitor that is not running Mastercam to free the entire graphics 
window for drawing.

Exercise 2-2: Hiding and Displaying a Manager
In this exercise, you hide and display the Toolpaths Manager.

1 Click the Toolpaths tab to bring it to 
the front of the stack of managers. 

2 Hide the Toolpaths Manager by 
clicking the Close button in its upper 
right corner.

3 Re-display the Toolpaths Manager 
by choosing Toolpaths in the 
Managers group on the View tab. 

TIP: You can use the keyboard shortcut [Alt+O] to toggle the display of 
the Toolpaths Manager.

4 Hide the Toolpaths Manager by 
clicking the Auto Hide button in its 
upper right corner.
INTRODUCTION TO MASTERCAM
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The Toolpaths Manager collapses 
against the left side of the graphics 
window. If you have other managers 
displayed, they will also collapse 
against the graphics window.

5 Hover over the Toolpaths tab to 
temporarily display the Toolpaths 
Manager.

6 Click Auto Hide again to redock the Toolpaths Manager.

Exercise 2-3: Customizing a Manager Display
In this exercise, you learn how to customize the background color of the Toolpaths 
Manager. Some managers have different options that are not shown in this exercise.
INTRODUCTION TO MASTERCAM
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1 Select Background color from the Options drop-down menu in the upper 
right corner of the Toolpaths Manager.

The Color dialog box opens.

2 Select the color shown to the right. 

3 Click OK.

The background of the Toolpaths 
Manager is the chosen color.

TIP: You set the color for lines, as well as font attributes, using the 
Options drop-down menu.
INTRODUCTION TO MASTERCAM
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4 Select Options, Restore default attributes to return the background color to 
its default setting for the remainder of this tutorial.

Exercise 2-4: Exploring the Recent Functions Manager
Recently used functions are recorded on the Recent Functions Manager. You can 
access one of these functions by selecting it in the list. 

In this lesson you will build a recent functions list, resize and dock the Recent Func-
tions Manager, and then access a previously used function.

1 On the Wireframe tab, click 
Rectangle.

The Rectangle function panel opens.

2 Follow the on-screen prompts and 
draw a rectangle of any size in the 
graphics window. Click OK when 
done.
INTRODUCTION TO MASTERCAM
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3 Click the Recent Functions tab to 
bring it to the front. 

Note that Create rectangle has 
been added to the top of the list. 

4 On the Wireframe tab, click Line 
Endponts.

5 Follow the prompts and draw a line 
of any size in the graphics window. 
Click OK when done. 

Note that Create Line Endpoint has 
been added to the list. 
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6 Click the Recent Functions tab and 
drag it onto the graphics window.

7 Resize the Recent Functions 
Manager until only the icons show. 
This keeps the recently used 
functions on screen while 
minimizing the space required. 
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8 Click the title bar of the Recent 
Functions Manager and drag it to 
any convenient location on the 
screen, or dock it on the right side of 
the graphics window as shown in the 
illustration. 

9 Click the Create rectangle icon to 
quickly access that previously used 
function. 

10 Follow the prompts to create 
another rectangle in the graphics 
window, and then click OK to close 
the Rectangle function panel.

11 Click and drag the Recent Functions Manager to the left side of the interface 
and dock it with the other managers. 

You have now completed Lesson 2 of the Introduction to Mastercam tutorial. In the 
next lesson, you learn more about the Mastercam Backstage.
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The File menu in Mastercam is also known as the Backstage. The Backstage is the area 
where you open, save, convert, manage, or print files. You also access the File menu to 
open System Configuration and set default system parameters, or open Options to 
modify the user interface. In addition, the File menu provides access to Help, tutorials, 
software updates, and connects you with the Mastercam community. 

This section provides a brief overview of the Backstage and some of its functions.

Lesson Goals
 Open and review the Backstage pages.

Exercise 3-1: Exploring Mastercam’s Backstage
Click File to open the Backstage view. The image below shows the Info page of the 
Backstage with links on the left side to other pages and functions. 

The following section provides brief descriptions of the some of the functions and 
pages located in the Backstage. Click each page to explore the Backstage.
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 Info Presents information and properties of the current Mastercam file. The 
Info page gives you access to functions that take action on the currently open 
file including, Project Manager, Change Recognition, Track Changes, 
AutoSave / Backup, and Repair File.

 New Opens a new file.
 Open Accesses the Open page where you can select a recent document or 

browse for a file to open. You can pin frequently used files or folders to the 
Recent Documents and Recent Folders sections.

 Open in Editor Opens a file using a file editor of your choice.
 Merge Imports and merges entities from an existing part file into the current 

file.
 Save/Save As Saves the current part file or saves the file with a new name. 

You can pin frequently used folders to the Recent Folders section of the Save 
As page. 

 Save Some Saves only entities that you select in the graphics window.
 Zip2Go Creates a compressed .ZIP or .Z2G file of the current file that includes 

your Mastercam configuration, machine definition, post files, tool and 
material libraries and other necessary files. A Zip2Go file is helpful when 
sharing file information with other users or technical support.

 Convert Provides access to Import and Export functions, as well as the 
Migration Wizard so that you can update older Mastercam files to the latest 
version.

 Print Previews, configures, and prints the current Mastercam file.
 Help Presents information about Mastercam and licensing. Includes links to 

the What’s New and ReadMe documents, tutorials, and the Help system. Visit 
this page to check for software updates. Some functions require an active 
internet connection.

 Community Links your account to Mastercam.com, the customer feedback 
program, and satisfaction surveys.

 Configuration Opens the System Configuration dialog box where you set 
system defaults for Mastercam.

 Options Opens the Options dialog box where you customize the Mastercam 
interface.

You have now completed Lesson 3 of the Introduction to Mastercam tutorial. In the 
next lesson, you will learn more about the Configuration files.
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The System Configuration dialog box defines and manages the configuration files that 
store Mastercam’s settings. You can change your system configuration or create a new 
configuration at any time. It is easy to switch from one environment to another 
because each configuration is saved to a separate file. 

In this lesson, you change options in the System Configuration dialog box to see the 
different kinds of settings that are stored within one configuration file. 

Lesson Goals
 Create a configuration file.
 Change system colors and CAD styles.
 Modify the size and opacity of on-screen controls.
 Set up AutoSave and Backup.

Exercise 4-1: Creating a Configuration File
In this exercise, you create a configuration file (.config). 

1 Select File, Configuration to open the System Configuration dialog box.
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2 Click the Save As button in the 
lower left corner.

The Save As dialog box displays.

3 Enter Tutorialconfig for the File 
name. 

4 Click Save.

Mastercam creates a new .config file. You can create multiple .config files 
using the same method.

In the following exercises, you save system settings to this configuration file.

Exercise 4-2: Changing System Colors
In this exercise, you change some default colors to customize Mastercam’s interface 
and geometry colors.

1 In the System Configuration dialog 
box, select the Colors page from the 
list.

2 Select Geometry color from the list.

You can see that Geometry color is 
currently assigned to color 1.
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3 Type 163 for the Color value and 
press [Enter].
Wireframe geometry you create will 
now use this color.

4 Select Background color (gradient 
start) from the list.

Color 111 is the current assignment.

5 Type 15 for the Color value and 
press [Enter].
The start of the gradient 
background is now white. 

6 Select None (Use Graphics 
background color) from the 
Gradient background direction 
drop-down.

This uses only the Background color 
(gradient start), instead of creating a 
gradient background.

7 Click Apply to save the settings on 
this page.
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8 Choose Yes to save all current settings to the Tutorialconfig.config file.

TIP: You can also change colors for 
Wireframe, Solids, and Surfaces of the 
current file by using the controls 
located in the Attributes group of the 
Home tab. See Setting System Attri-
butes for the Current File.

These are just some of the color changes that you can make to customize your 
Mastercam interface. 

Exercise 4-3: Changing CAD Settings 
In this exercise, you make changes to the CAD Settings page. 

1 Select the CAD Settings page from 
the list.

You will use the CAD Settings page 
to specify design defaults, such as 
default line and spline attributes.

2 In the Default attributes section, 
select the Line style shown in the 
illustration to the right.

Wireframe geometry you create will 
now use this line style.
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3 Select the Line width shown in the 
illustration to the right. 

Wireframe geometry you create will 
now use the selected line width.

4 Click OK in the System Configuration dialog box.

5 Click Yes to save all current settings to the Tutorialconfig.config file.

6 Choose Rectangle on the 
Wireframe tab. 

The Rectangle function panel opens.

7 Follow the prompts to create a rectangle, and then click OK in the Rectangle 
function panel

The line style and width of the 
geometry matches the selections in 
the CAD Settings page of System 
Configuration, as well as the 
geometry color set in the Colors 
page.
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Exercise 4-4: Changing the Size and Opacity of On-screen Controls
In this exercise you will set the size of the on-screen gnomons and text, and change 
the opacity of the Selection Bar and Quick Mask buttons. 

1 Click File, Configuration to open the System Configuration dialog box.

2 Select the Screen page.

3 In the Graphics window overlays section type 1.5 for Scale display 
gnomons and text and press [Enter]. The size of the elements is immediately 
changed in the graphics window.

4 The slider control for Selection controls opacity adjusts the opacity of the 
Selection Bar and Quick Masks. The setting only affects the static display of 
the on-screen controls. The Selection Bar and Quick Mask controls will 
become opaque when you hover over them. Move the slider to the left to 
increase transparency and to the right to increase opacity. Choose any opacity 
setting you wish.
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5 Click Apply to save the settings on 
this page.

6 Select Yes to save the settings to the 
configuration file.

Exercise 4-5: Setting up AutoSave and Backup
When you are working on a part, Mastercam can save your work automatically, at 
intervals that you specify. Mastercam can also save versions of your files as backups. 

In this exercise, you set up these functions.

1 Expand the Files category and select 
the AutoSave / Backup page.

2 In the AutoSave / Backup page, do the following:

 Select the AutoSave checkbox to activate the AutoSave options.
 Enter 10 for Interval (in minutes).
 Select the Mastercam Backup Files checkbox to activate the automatic 

backup feature.

Mastercam will save your work automatically every 10 minutes and keep the 
10 most recent versions of your file.

3 Select the Files page to view the location of your backup files. 
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4 Choose Backup files (Mastercam format) in the Data paths list. The path 
displays in the Selected item box as shown in the following illustration.

5 Select mcamxm.config <Metric> from the Current drop-down to enable the 
Metric configuration for the remainder of this tutorial.

6 Click OK.
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NOTE: If you would like to learn more about the individual settings on 
any System Configuration page, click the Help button located in the 
lower right-hand corner of the dialog box.

You have now completed Lesson 4 of the Introduction to Mastercam tutorial. In the 
next lesson, you will learn more about the Customize dialog box.
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5Customizing Mastercam

In this lesson, you learn more about the Options dialog box. Use the Options dialog 
box to customize your Mastercam workspace, including tab and interface options, the 
graphics window context menu, and keyboard shortcuts.

Lesson Goals
 Customize the graphics window context menu.
 Map Mastercam functions to keyboard shortcuts.
 Set display options for tabs and interface colors.

Exercise 5-1: Customizing the Graphics Window Context Menu
In this exercise, you customize the graphics window context menu that displays when 
you right-click anywhere in the graphics window. Customizing the context menu 
allows you quick access to your commonly used functions.

1 Click File, Options to open the Options dialog box.

2 Select the Context Menu page.
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Categories of functions are displayed on the left side of the dialog box, while 
the right side contains the Context Menu list as shown in the previous 
illustration.

3 Right-click the last item in the 
Context Menu list and select Insert 
Separator.

A separator line appears after the 
last item.

4 Select File from the Category drop-
down list.

5 Select the Save As function in the Category list and SEPARATOR in the 
Context Menu list, and then click Add.
INTRODUCTION TO MASTERCAM



MAPPING FUNCTIONS TO KEYBOARD SHORTCUTS   61
6 Click OK to save these changes to the right-click menu.

7 Right-click in the graphics window 
to see the updated context menu. 

Save As has been added to the 
bottom of the menu.

Exercise 5-2: Mapping Functions to Keyboard Shortcuts
In this exercise, you map a Mastercam function to a shortcut key.

1 Click File, Options to open the Options dialog box.

2 Click Customize next to Keyboard 
shortcuts at the bottom of the 
Quick Access Toolbar page or 
Customize Ribbon page.

The Customize Keyboard dialog box opens.
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3 Select Home from the Categories list.

The Commands list populates with functions from the Home tab.

4 Select Statistics from the Commands list.

You will notice that the Current Keys list is blank. That is because there are no 
shortcut keys assigned to this function.

5 Click in Press new shortcut key and 
type [Ctrl+Shift+H] to create a new 
shortcut key.

6 Click Assign to map this shortcut 
key to the Statistics function.

7 Click Close to exit the Customize Keyboard dialog box, and then OK to close 
the Options dialog box.

8 In the graphics window, press [Ctrl+Shift+H] to access the Statistics function.

The Statistics dialog box displays a 
summary of the entities in the 
current file, including total number 
of visible entities by type, and the 
number of operations and tools.

In this example, Statistics reports 
four lines because of the rectangle 
created in the previous lesson.

9 Click OK to close Statistics.
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Exercise 5-3: Setting Mastercam Display Options
In this exercise, you set some of Mastercam’s display options. 

1 Select File, Options to open the Options dialog box.

2 Select the Options page.

3 Under the Manager panels section, select Large icons.

4 Under Interface, select Medium for 
the Theme and set the Accent color 
to Green.

The Accent color changes the color 
of the Status Bar, the active tab, and 
the highlight color of functions. 
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5 Click OK to close Options and view the Mastercam interface. The interface has 
larger icons and the selected green theme.

6 Click File, Options and return the settings to the original options or any other 
settings you choose. 

You have now completed Lesson 5 of the Introduction to Mastercam tutorial. In the 
next lesson, you learn more about working with files.
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Mastercam not only saves and loads its own file types, (.mcx-*, .mcam), but also many 
common file formats, including the following:

Loading and saving native Mastercam files is 
as easy as selecting Open, Save, or Save As 
from the Backstage shown to the right. You 
can also choose one of these commands on 
the QAT.

You can also open files by:

 Dragging a Mastercam file or third-
party compatible file from Windows 
Explorer and drop it in Mastercam’s 
graphics window.

 Dragging and dropping a file onto 
the Mastercam desktop icon to 
open a new instance of Mastercam.

Lesson Goals
 Open a non-Mastercam file.
 Import multiple files.
 Save patterns (Save Some).
 Export one or more files.
 Use Zip2Go files.

 SOLIDWORKS  CATIA

 AutoCAD  IGES

 Parasolid  ProE/Creo

 Solid Edge  Alibre

 Autodesk Inventor  Cadkey

 SpaceClaim  Rhino
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Exercise 6-1: Opening Non-Mastercam Part Files
Importing files from other applications is similar to opening native Mastercam files. 
Depending on the file, you might need to specify how Mastercam imports elements of 
the file. In this exercise, you will convert a SOLIDWORKS (.sldprt) file to a Mastercam 
part.

1 Select File, Open. Click Computer 
and then Browse.

The Open dialog box displays.

NOTE: Click Don’t Save if a dialog displays asking if you want to save 
changes to the current Mastercam file.

2 In the Open dialog box, select 
SOLIDWORKS Files (*.sldprt; 
*sldasm) from the drop-down.

The dialog now displays only 
SOLIDWORKS parts.

3 Navigate to SW_Part.sldprt, which was provided with this tutorial.

4 Select the file, but do not double-click it.

5 Click the Options button.

The SOLIDWORKS File Parameters 
dialog box opens.
INTRODUCTION TO MASTERCAM



OPENING NON-MASTERCAM PART FILES   67
When importing a non-Mastercam file, you might need to change the options 
so that it can be read properly into Mastercam. Use these options to control 
how files are read into the Mastercam database. 

6 Click OK without changing anything.

7 Click Open in the Open dialog box. Mastercam converts and opens the part.

8 Right-click in the graphics window 
and select Isometric (WCS) from 
the menu.
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See the following illustration of the imported SOLIDWORKS file.

9 If necessary, click Outline Shaded to 
view the part as a solid.

You learn more about the graphics window and views in later sections of the tutorial. If 
you would like more information, you can also refer to the Mastercam Help.

Exercise 6-2: Importing Multiple Part Files
When you have many files to import into Mastercam, you can convert them all at once 
using the Import Folder command.
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1 Select File, Convert and then click Import Folder.

The Import folder dialog box opens.

2 Select SOLIDWORKS Files (*.sldprt; 
*sldasm, *slddrw) from the Import 
from files of type drop-down.

3 Click the Browse button to the right 
of the From this folder box.

The Browse For Folder dialog box 
opens.
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4 Select the location where you stored 
the tutorial files and then click OK.

5 Click the Browse button to the right 
of the To this folder box.

6 Browse to \Documents\my 
mcam2017\mcx and then click OK.

7 Click OK in the Import folder dialog 
box.

Mastercam converts all 
SOLIDWORKS files in the selected 
tutorial files directory, but does not 
display the converted files in the 
graphics window. In this instance, 
there is only one. You can find the 
resulting Mastercam file 
(SW_Part.mcam) in the \mcx folder.
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Exercise 6-3: Saving Patterns (Save Some)
A pattern is a set of reusable entities. For example, you may have a bolt that you use in 
many different parts. By saving that bolt as a pattern, you can merge it with your other 
parts as needed.

When you save a Mastercam part, you can choose to save the entire file or to save 
only selected entities. Saving a set of selected entities is one way to create a pattern 
from a part file. This exercise demonstrates the File, Save Some command, which lets 
you choose the entities to save.

1 Open 2D_CHAMFER_MM.mcam, which was provided with this tutorial. In the 
Open dialog box, you might need to change your file type to Mastercam 
Files (*.mcam).

2 Select File, Save Some.

3 Choose Wireframe on the Status 
Bar to show the wireframe of the 
solid body making it easier to select 
the arcs.
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4 Select the five arcs shown in the picture below. The arcs change color when 
they are selected.

5 Press [Enter] to accept the selection. The Save As dialog box opens.

6 Type 2D_CHAMFER_ARCS.mcam for the File name. 

7 Click Save or press [Enter] to save the file. Mastercam saves only the selected 
arcs.

8 Open 2D_CHAMFER_ARCS.mcam, and notice that it contains only the arcs that 
you selected.

Exercise 6-4: Exporting a Single File
When exporting, you might need to set a few options so that you get the type of file 
you expect. In most cases, you need only select the software package to which you are 
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exporting the file. In this exercise, you learn to convert a single file from one format to 
another.

1 Open 2D_CHAMFER_MM.mcam, which was provided with this tutorial.

2 Select File, Save As and then click Browse.

The Save As dialog box opens.

3 Select StereoLithography Files 
(*.stl) in the Save as type drop-
down list.

4 Click Options.

The Save as an STL File dialog box 
opens.

5 Select the ASCII option.

6 Click OK to close the Save as an STL File dialog box.
INTRODUCTION TO MASTERCAM



74  MASTERCAM 2017 / Working with Files
7 Click Save in the Save As dialog box.

Mastercam saves the file in ASCII StereoLithography format.

TIP: Because the StereoLithography file is ASCII, you can view it with 
any text editor, such as Notepad, as shown below.

Exercise 6-5: Exporting Multiple Files
When you have many Mastercam files to export into a different format, you can 
convert them simultaneously using the Export Folder command. This exercise 
demonstrates how this function works.
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1 Select File, Convert and then click Export Folder.

The Export folder dialog box opens.

2 Select IGES Files (*.igs, *iges) from 
the Export to files of type drop-
down.

3 Click the Browse button to the right 
of the From this folder box.

The Browse For Folder dialog box 
opens.
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4 Select the directory where you 
stored the tutorial parts, and then 
click OK.

5 Click the Browse button to the right 
of the To this folder box.

6 Browse to \Documents\my 
mcam2017\mcx and click OK.

7 Click OK in the Export folder dialog 
box.

Mastercam converts the files in the 
selected tutorial folder. You can find 
the resulting IGES files in your \mcx 
folder.
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Exercise 6-6: Using Zip2Go
You use the Zip2Go utility to gather and compress the current open Mastercam part 
data into a .ZIP or .Z2G file. These files can then be opened and viewed with most zip/
unzip programs. This is especially useful if you are trying to share information with 
other users or technical support.

Zip2Go scans the machine groups in your current file and captures certain information 
such as your Mastercam configuration, machine definition, post files, tool and material 
libraries, and other necessary files. In this exercise, you run Zip2Go to compress a file.

1 Open Brace.mcam, which was provided with this tutorial.

2 Select File, Zip2Go.

The Zip2Go dialog box opens.

Use this dialog box to create and view Zip2Go files. The file list displays 
information about the files contained in the Zip2Go archive. You can also 
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select files that you want, and deselect files that you do not want to include in 
the Zip2Go file. For this tutorial, you keep the default settings.

3 Select File, Options from the menu 
bar.

The Options dialog box opens.
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Use this dialog box to configure the default settings for Zip2Go. Make sure 
the current default output folder is your \Documents folder.

4 Click OK to close the Options dialog box.

5 Click Create Zip2Go. 

The Save Zip2Go file dialog box opens. By default, Mastercam creates a 
zipped file with a .ZIP extension in the selected folder. You can change the file 
type to .Z2G in the Save as type drop-down.
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6 Click Save. The Zip2Go file list is populated by files included in the Zip2Go file 
you created.

7 Click OK to close the Zip2Go dialog box.

NOTE: If the part file contains no toolpaths, Zip2Go will only package 
the configuration files.

You have now completed Lesson 6 of the Introduction to Mastercam tutorial. In the 
next section, you will learn more about the graphics window and related functions.
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The graphics window is your workspace in the Mastercam interface. 

Mastercam provides many tools you can use to change the graphics window display 
to suit your needs. This section introduces some of these tools, and teaches the basic 
skills you need to manage your Mastercam workspace.

Lesson Goals
 Customize on-screen prompts.
 Change standard views.

Exercise 7-1: Customizing Function Prompts
When you use a function that requires your input, such as selecting an entity, 
Mastercam provides brief directions in a prompt. You can customize these prompts to 
change their size, text color, background color, and position on the screen.
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In this first lesson, you alter the size and appearance of the function prompts.

1 Click File, New.

2 On the Wireframe tab, select Point 
Position.

The Point Position function panel 
opens.

Notice the prompt displayed in the upper left corner of the graphics window.

3 Right-click the prompt and select 
Small font.

The prompt now displays smaller as 
shown in the illustration to the right.

4 Right-click the prompt and select 
Background color.
The Colors dialog box opens.
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5 Enter 167 in the Current color 
attribute box.

6 Click OK to change the background 
color and exit the Colors dialog box.

The function prompt now displays 
with a blue background.

NOTE: If you try to make the prompt color the same as the background 
color, a warning displays. 

7 Move the function prompt by clicking and dragging it to a new location on 
your screen.

8 Return the prompt to its default attributes for the remainder of this tutorial, 
by doing the following:

a Set the font size to Large font.
b Set the Background color to 15.

9 Click Cancel to close the Point Position function panel.

Exercise 7-2: Changing Standard Views
In this exercise, you change your graphics view (Gview) using standard views.

1 Open ANGLEBLOCK-MM.mcam, which 
was provided with this tutorial. The 
part opens in Isometric (WCS) view.
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2 Click the Show Axes drop-down on 
the View tab and deselect World, 
Cplane, and Tplane, ensuring only 
WCS remains selected.

The coordinate axes show the origin 
and the part orientation to help you 
visualize the part in 3D space. 

3 Click Show Axes on the View tab or 
press [F9] to toggle the display of 
the WCS axes.

4 Click the Show Gnomons drop-
down on the View tab and deselect 
Cplane and Tplane, ensuring only 
WCS is selected.

5 Click Show Gnomons or press 
[Alt+F9] to toggle the display of the 
on-screen gnomon.
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6 On the View tab, click Top in the 
Graphics View group.

7 Click Unzoom 80% on the View tab 
to reduce the size of the part on the 
screen.

You are now viewing the part as if you were above it looking down.

8 You can also use the right-click 
menu to change the view. Practice 
switching to other views using this 
menu.

9 When finished, return the part to Isometric view for the next lesson.

10 Click Show Gnomons to turn off the display of gnomons in the graphics 
window.
INTRODUCTION TO MASTERCAM



86  MASTERCAM 2017 / Working With the Graphics Window
You have now completed Lesson 7 of the Introduction to Mastercam tutorial. In the 
next lesson, you learn more about viewing your part.
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8Viewing Your Part

Mastercam provides several tools and methods for changing the appearance of the 
geometry and toolpaths in the graphics window. In this lesson, you learn different 
ways of viewing your part, to hide portions of your part, and to create and use View-
sheets.

Lesson Goals
 Fit all entities in the graphics window.
 Use zoom functions to magnify your view of selected entities.
 Dynamically rotate and pan entities in the graphics window.
 Create a viewsheet.
 Blank and hide entities.

Exercise 8-1: Viewing All Entities
In this exercise, you set up your graphics window to view all entities in a Mastercam 
part file.

1 If necessary, open the tutorial part ANGLEBLOCK-MM.mcam. Change your view 
to Isometric, and press [F9] to show the axes.

2 Choose Fit on the View tab or press 
[Alt+F1]. 

Fit and several other Zoom 
commands are also available in the 
right-click menu.



88  MASTERCAM 2017 / Viewing Your Part
The part now fills the entire graphics window.

3 Choose View, Unzoom 50% to decrease the size of the display to 50%. This 
creates a border of free space around the part.

Exercise 8-2: Zooming In and Out 
In this exercise, you practice different techniques for viewing specific areas of detail in 
a Mastercam part.
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1 Place your cursor in the upper left 
quadrant of the graphics window.

2 If your mouse has a middle mouse wheel, spin it back and forth to 
dynamically zoom in and out. You can also press the [Page Up] and [Page 
Down] keys on your keyboard to zoom in and out.

3 Click Fit or press [Alt+F1] to fit the part to the screen.

4 Choose Window. 

5 Click and drag a diagonal window around the upper section of the part as 
shown below.
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6 Click to set the zoom window. Mastercam scales the selected area to fit the 
entire graphics window.

7 Right-click the graphics window and choose Fit.
8 Select the circle on the front of the 

angle block as shown in the 
illustration.

9 Choose Selected from the Window 
drop-down on the View tab.
INTRODUCTION TO MASTERCAM



ROTATING YOUR PART VIEW   91
The selected entity is scaled to fit the graphics window.

10 Press [Esc] to clear the selection.

Exercise 8-3: Rotating Your Part View
This exercise shows how to set the preference for the action your middle mouse 
button or wheel performs in the graphics window (rotate or pan). You also learn to 
dynamically rotate entities in the graphics window so that you can see them from any 
angle.

1 Select File, Configuration to open 
System Configuration.

2 Expand the Screen group and select 
View Settings.
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3 If necessary, set Middle button/
wheel to Rotate.

By choosing Rotate, Mastercam sets 
dynamic rotation as the primary 
function when you click and hold the 
middle mouse button or mouse 
wheel. 

4 Click OK to close the System Configuration dialog box and then click No, to 
use these settings for this session only.

5 Set up the part in the graphics window, as follows:

a Set the Gview to Front.
b Click Unzoom 80%.

6 Middle-click in the graphics window where indicated below and continue to 
hold down the middle mouse button or wheel as you move the mouse slowly 
in a circular motion.

This action rotates the part in space about the selected position and lets you 
see it from any angle.

7 Let go of the middle mouse button/wheel to finish rotating the part.
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The axes symbol (gnomon) in the 
graphics window changes as you 
rotate the part. The Gview name in 
the graphics window no longer 
displays because you are not in a 
standard view.

8 Return the view to Isometric, and fit the part to the screen.

TIP: You can also choose Dynamic Rotation from the right-click menu 
and follow the on-screen prompts to rotate the part.

Exercise 8-4: Panning You Part
In this exercise, you change your view in the graphics window as if you were moving a 
camera lens to the left or right, and up and down over the part.

1 Hold down the [Shift] key, middle-click in the graphics window where 
indicated, and continue to hold down the button/wheel while you move the 
mouse up, down, side to side, and around.
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It appears that you have picked up the part and are moving it in the direction 
of the mouse. However, the entities are not physically moved in space, only 
the display changes. The Gview does not change as you pan the entities. 

2 Release the [Shift] key while still holding down the middle mouse button/
wheel and you can rotate the part. Press the [Shift] again to return to 
panning.

3 When you finish panning, release the [Shift] key and the middle mouse 
button/wheel at the same time to exit the function.

Exercise 8-5: Using Viewsheets
Mastercam allows you to view your part in different orientations by using viewsheets. 
Viewsheets make viewing a large part easier, as you can set up multiple viewsheets 
with different views. When you save your part file, Mastercam stores the viewsheet 
settings along with the part.

In this exercise, you create a viewsheet.

At the bottom of the graphics window, 
notice a tab named Viewsheet #1. This is the 
main view of your part and cannot be 
deleted.

1 If necessary, fit the part to the graphics window and set the view to Isometric.

.2 Choose New in the Viewsheets 
group on the View tab. Alternately, 
you can right-click Viewsheet #1 
and select New Viewsheet from the 
menu. 

3 Press [Enter] to accept the default 
name. 

Viewsheet #2 is created and 
displayed next to Viewsheet #1.
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4 Right-click in the graphics window 
and select Right (WCS) to view the 
part on its right side. 

5 Select Viewsheet #1 again.

Notice that the view did not change on Viewsheet #1. Each viewsheet can 
contain different views and planes.

6 Right-click Viewsheet #1 and select 
Settings from the menu.
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The Viewsheet Settings dialog box opens.

You can use the Viewsheet Settings dialog box to indicate which settings to 
save to the viewsheets. These settings only apply to the selected viewsheet 
tab.

7 Click OK to exit the Viewsheet Settings dialog box without changing anything.

Exercise 8-6: Blanking and Hiding Entities
In larger and more complicated parts, it can be difficult to select geometry for tool-
paths or geometry manipulation. Mastercam allows you to Blank entities, which 
removes selected entities (from any level) to reduce screen clutter.

Similar to Blank is Hide. With Hide, you select the entities that will remain in the 
graphics window; all unselected entities are removed. Both functions have their bene-
fits, but consider these differences:

 You can save blanked entities; hidden entities are not saved.
 Choose Hide/Unhide to remove many entities from the display, or to quickly 

restore hidden entities.
 Choose Blank to selectively remove and restore a limited number of entities 

from the display. Choose Unblank to restore blanked entities.
In this exercise, you first blank and unblank geometry, and then hide and unhide 
geometry.

1 Open BLANK_PART.mcam, which was provided with this tutorial. 
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If prompted to save ANGLEBLOCK-MM.mcam, choose Don’t Save.

2 On the Home tab, select Blank.

Mastercam then prompts you to 
select entities to blank.

3 Select the geometry shown below:

4 Press [Enter] or choose End 
Selection located below the 
Selection Bar to accept the 
selections.
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The selected geometry no longer displays in the graphics window.

Now, you will unblank the geometry selected in the previous steps.

5 Select Unblank from the Blank 
drop-down.

The graphics window changes to 
display entities that have been 
blanked, so that you can select 
which ones to unblank and which 
ones to keep hidden.

6 Select all of the blanked entities and press [Enter]. The part should be whole 
again.

Next, you use the Hide/Unhide function.
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7 Select Hide/Unhide.

Mastercam prompts you to select 
which entities to keep.

8 Select the geometry shown below:

9 Press [Enter] or choose End Selection to accept the selection.
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The graphics window hides the unselected geometry.

Next, you unhide the geometry using Unhide Some. 

10 Select Unhide Some.

Mastercam then prompts you to 
select entities to keep on the screen.
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11 Select the geometry shown below:

12 Press [Enter] to accept the selections.

Mastercam unhides the selected geometry. Any geometry that was hidden 
and not selected remains hidden. 
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13 Click Hide/Unhide to show all entities.

You have now completed Lesson 8 of the Introduction to Mastercam tutorial. In the 
next lesson, you learn more about levels.
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A Mastercam file can contain separate levels for wireframe, solids, surfaces, drafting 
entities, toolpaths, and other part data. Organizing your file data by levels lets you 
control the areas of the drawing that are visible and the entities you can select in the 
graphics window.

This control makes it easier to work with the file and helps prevent you from affecting 
areas of the drawing you do not want to change.

You can create and name up to two billion levels and set any one to be the active, 
current working level. For each level you create, you assign a unique number and, 
optionally, a name. Mastercam’s Levels Manager provides a central location where you 
can view and create levels, and set their properties.

Lesson Goals
 Explore the Levels Manager.
 Modify the Levels Manager display options.
 Turn level displays off and on.
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 Change the active level.
 Create a new level.
 Move selected entities to a different level. 

Exercise 9-1: Exploring the Levels Manager
When first opening a Mastercam file, you may not be aware of all entities in the part 
because they may exist on levels that are not displayed in the graphics window. It is a 
good practice to first access the Levels Manager and view all of the levels in the file.

The Levels Manager is movable and dockable. You can dock it to a fixed location on 
the interface, float it anywhere on the workspace, or move it to another monitor. These 
settings are modal, which means that Mastercam remembers the settings even after 
you close the application.

In this exercise, you explore the Levels Manager and modify some display options.

1 Open LEVELS_PART.mcam, which was provided with the tutorial and save it 
with a new name.

If prompted to save BLANK_PART-MM.mcam, choose Don’t Save.

2 Click the Levels tab and drag and 
drop it anywhere on the workspace. 
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If the Levels tab does not show, 
select Levels in the Managers 
group of the View tab.

3 Resize the Levels Manager by 
clicking and dragging any of its 
edges.

The Levels Manager shows all levels that exist in the current part file, their display 
status, and the number of entities per level. 

Active level 
parameters display 
in this section.

Use any column 
heading to sort the 
levels grid. To sort, 
click the column 
heading. To change 
the sort order 
(ascending or 
descending), click 
again.

Use these 
options to filter 
the levels grid.

The checkmark in 
the Number column 
indicates the current 
active level. 
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4 Click Hide level properties to hide 
the property controls in the lower 
section of the Levels Manager and 
maximize the space allotted to the 
levels grid. 

5 Click Hide level properties again to 
show the controls at the bottom of 
the Levels Manager.

6 Click Display options, Contrast 
rows to apply shading to every 
other row used in the grid.

7 Dock or locate the Levels Manager in a convenient location.

In the next exercise, you learn to turn level displays on and off.

Exercise 9-2: Showing or Hiding Levels
In this exercise, you change the graphics window display by turning level display on 
and off. To select or otherwise work with an entity in the graphics window, its level 
must be visible.

1 In the Visible column for level 
2:Solid, click once to turn off the 
display of that level.
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The change is immediate in the graphics window.

If necessary, drag the Levels Manager to a position that gives you a better 
view of the graphics window.

2 Click again in the Visible column for level 2:Solid to toggle the level display 
on.

3 Try turning off the display of level 
1:Wireframe. 

When Active level is always visible 
is selected in Display options, you 
cannot turn off the active level 
display in the graphics window.

CAUTION: Turning off the display of the active level while you are 
working in that level is not recommended. However, it may occasionally 
be necessary.

4 Click Display options and deselect 
Active level is always visible. 

!!
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5 Use Turn all levels off and Turn all 
levels on options to toggle the 
display of all levels on or off. 

6 Select Active level is always visible 
again. 

7 Make sure all levels are visible before continuing on to the next exercise.

Exercise 9-3: Changing the Active Level
Any geometry that you create is always placed on the active level. There can only be 
one active level at a time, but you can change the active level as often as necessary to 
work with the part. In this exercise, you change the active level using several methods.

1 In the Levels Manager, click once in 
the Number column of level 2:Solid 
to set it as the active level. A 
checkmark indicates that it is now 
the active level.

The level field located in the 
Organize group on the Home tab 
also shows that level 2:Solid is the 
active level.

2 Select level number 1:Wireframe 
from the levels drop-down to make 
it the active level. 

A checkmark appears in the 
Number column for level 1.

3 In the Levels Manager, turn off the visibility of level 2:Solids.

4 Position the cursor anywhere in the 
row for level 2:Solids, right-click and 
choose Make active. 

A checkmark appears in the 
Number column for level 2.
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Level 2:Solids is also visible because 
the Levels Manager display option, 
Active level is always visible is 
selected. 

Exercise 9-4: Creating a Level and Assigning Entities
In this exercise, you create and name a level, and then assign entities to that level. 

1 In the Levels Manager, click Add a 
new level.

Mastercam adds a new level to the 
Levels Manager grid and sets it as 
the active level.

2 In the Name field, type Tutorial. 
The Levels Manager grid updates to 
show the new name. Although level 
names are optional, descriptive 
names are helpful.

3 Make level 1:Wireframe the active level.
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4 Use the Display options in the lower 
section of the Levels Manager to 
control the visibility of levels. You 
can show only used levels (those 
assigned to entities), levels that are 
named, (regardless of whether they 
are used), either used or named 
levels, or limit the display to a range 
of level numbers.

5 Click Used and notice that level 
3:Tutorial is no longer visible 
because there are no entities 
assigned to it. 

6 Click Used or named to restore visibility of all levels.

7 Make level 3:Tutorial the active level.

8 Select Point Position on the 
Wireframe menu.
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9 Click a few times in different places in the graphics window to create some 
points.

10 Click OK on the Point Position 
function panel to exit the function.

11 Verify that the new geometry was 
created on level 3:Tutorial. In the 
Levels Manager the number of 
Entities is not 0.

NOTE: Your number of points may be different than what is shown in 
the previous illustrations.

12 Practice turning level displays on and off and changing the main level.

When you are ready, turn on the visibility for all levels and continue with the 
next exercise.
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Exercise 9-5: Moving Entities to a Different Level
In this exercise, you create a new level using a different method and move entities 
from one level to another. You can use the same basic procedure to copy entities to a 
different level.

1 In the Levels Manager, enter 4 in the 
Number field, and then enter Labels 
for the level Name.

The new level, 4:Labels becomes the 
active level.

2 Make level 1:Wireframe the active level.

3 On the Home tab, click Change 
Level.

4 Mastercam prompts you to select 
entities. Use the following steps to 
select all labels located on level 
1:Wireframe.

a Choose the Quick Mask, Select 
all advanced.

The Select All dialog box 
displays.
INTRODUCTION TO MASTERCAM



MOVING ENTITIES TO A DIFFERENT LEVEL   113
b In the Select All dialog box, 
create a selection mask for all of 
the label entities. 

A selection mask is a defined set 
of criteria that you use to quickly 
select entities in the graphics 
window.

 Select the Entities checkbox.
 Expand the Drafting node 

and select Labels in the list.
 Click OK.
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In the graphics window, Mastercam highlights all the notes, indicating that 
they are all selected.

5 Press [Enter] or choose End Selection located below the Selection Bar.

6 The Change Levels dialog box displays.

TIP: You can also use general selection methods to pre-select entities 
before choosing the Change Level option. When you pre-select entities, 
Mastercam does not prompt you to select additional entities and you 
advance directly to the Change Levels dialog box.
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7 In the Change Levels dialog box 
complete the following steps:

a Choose Move.

b Deselect the Use Active Level 
checkbox.

c Type 4 in Number.
d Click OK.

8 In the Levels Manager, verify that 
level 4:Labels now contains the four 
label entities that were on level 1. 

Level 1:Wireframe contains four 
fewer entities.

9 Save your part.

You have now completed Lesson 9 of the Introduction to Mastercam tutorial. In the 
next lesson, you will learn more about views and planes.
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10Understanding Views and Planes

Mastercam uses a 3D Cartesian coordinate system to locate your work in three-dimen-
sional space. This means that geometry and toolpath positions are expressed in terms 
of three coordinate axes: X, Y, and Z. Each axis is signed, which means it has a positive 
and negative direction.

In previous lessons, you learned about standard views and planes. In this lesson, you 
learn more about creating your own planes and using them for geometry creation.

Lesson Goals
 Understand views and planes.
 Customize the Planes Manager.
 Adjust follow rules.
 Create a custom plane.
 Use a custom plane for geometry creation.
 Create a new plane using the dynamic gnomon.

Exercise 10-1: Exploring the Planes Manager
You use views and planes in Mastercam for many drawing and machining purposes.

A plane is any two-dimensional slice of a 3D coordinate system. Examples of planes 
include the XY plane in a 3D coordinate system, or a face of your part, no matter its 
angle.

A view is a plane with an origin and orientation. For example, the Left side view and 
Right side view are both aligned with the same plane; but a clockwise arc in one view is 
the opposite of a clockwise arc in the other view. 

Mastercam includes a number of pre-defined views, which you explored in Lesson 7. 
These include Top, Front, Right, Isometric, and others. 

The work coordinate system (WCS) refers to the alignment of the coordinate system 
itself. You can choose to align the coordinate system axes with any plane you wish. 
When this happens, you map the XY plane to the plane of the view. The origin of the 
view becomes your new (0,0,0) point. The view becomes the Top plane in the new 
working coordinate system.
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NOTE: If you would like to learn more about the work coordinate 
system, try the Introduction to the Work Coordinate System tutorial 
located on our website.

This section introduces some ways planes are used and some ways to access them. 
You can use views and planes for three main functions:

 Graphic views (Gviews)— A Gview determines the angle from which you are 
looking at the part in the graphics window.

 Construction planes (Cplanes)—When you draw geometry, the Cplane is the 
plane in which the geometry is created. This does not have to be the same as 
the Gview. For example, you can look at your part in Isometric Gview, while 
drawing geometry in the Front Cplane.

 Tool planes (Tplanes)— This is the plane that is typically normal to the tool 
axis. Tplanes are only used when creating toolpaths. Tool planes determine 
the tool orientation. In almost all cases, your Cplane will be the same as your 
Tplane (the most common exceptions are mill/turn operations).

You use Planes Manager to select, edit, create, and manage planes.
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Some of the functions of the Planes Manager include:

 Creating new planes
 Setting Cplanes, Tplanes, and WCS to selected planes
 Setting or changing the origin of planes
 Assigning work offsets to planes 

In this exercise you will open the Planes Manager and experiment with display options 
and follow rules.

1 Open BRACE.mcam, which was provided with the tutorial. Save the file with a 
new name.

2 If necessary, click Outline Shaded 
on the Status Bar to show the part as 
a solid.

3 Select the Planes tab to bring the 
Planes Manager to the front. If the 
Planes tab is not displayed, select 
Planes on the View tab.

4 Click Display options, Always 
display gnomon.
The gnomon for the currently 
selected plane displays in the 
graphics window whether or not the 
Planes Manager has focus. 

5 Choose Display options, Contrast 
Rows to customize the planes grid 
by shading every other used row. 

6 Click the Follow rules drop-down to 
view the current settings as shown in 
the illustration. With the current 
settings, when you change the 
Gview of a plane, the Cplane and 
Tplane will follow. 

Do not alter any settings. 
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7 Click in the G column of the Bottom 
plane to set the Gview to bottom. 
Note that Cplane and Tplane follow 
the Gview as directed by the follow 
rules. 

8 Choose the Follow rules drop-down 
and deselect Cplane follows Gview.

9 Click in the G column of the Top 
plane to set the Gview to top. Note 
that Cplane and Tplane no longer 
follow the Gview as directed by the 
new follow rules.

10 Click the Follow rules drop-down 
and reselect Cplane follows Gview. 

11 Click in the G column of the Iso 
plane to return the Gview to 
isometric. Note that Cplane and 
Tplane remain in the Top plane as 
the follow rule, Cplane = Top in Iso 
Gview is selected.

Exercise 10-2: Creating a Custom Plane
In this exercise, you create a custom plane aligned with the slanted face of the part 
and add it to the list of system planes.
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1 Select From solid face in the Create 
a new plane drop-down.

2 Select the slanted face of the part, shown below:
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3 In the Select plane dialog box, click the arrows to cycle through the possible 
views. For most applications, it make sense to have +Z pointing away from the 
part.

4 Cycle to the view shown in the following illustration.

5 Click OK in the Select plane dialog box. 
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The New Plane dialog box opens.

6 Enter FACE OF PART as the Name 
of the new plane.

7 Select Set as Cplane.

8 Click Select to choose a new point 
for the origin.

9 Select the point at the lower-right 
corner of the face.

10 Click OK to close the New Plane dialog box.
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Your new plane, FACE OF PART 
displays in the planes grid.

Exercise 10-3: Using a Custom Plane for Drawing Geometry
In this exercise, you create geometry using the new Cplane. You see that the new 
plane determines the orientation of the geometry. You then set the Gview to the new 
plane.

1 Select Circle Center Point from the 
Wireframe tab.

2 Select Origin from the AutoCursor 
drop-down on the Selection Bar.

3 In the Circle Center Point function 
panel, enter a Radius of 80.0 and 
then click OK. 
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Mastercam creates a circle that is 
aligned with the face of the part. It is 
centered on the origin on the 
custom plane not the system origin.

4 Click View, Show Axes and turn on 
all the axes.

5 If necessary, press [F9] to display the XYZ axes. Each axes type displays in a 
different color. Since Cplane and Tplane are the same, the axes display as 
dotted lines. Experiment by turning individual axes on and off.
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6 In the Planes Manager, click in the G column of the FACE OF PART plane to 
set the Gview.

You are now looking straight down into the face of the part. The Gview is 
aligned with the custom plane that you just created. 

7 Save your part.

Exercise 10-4: Creating a New Plane Using the Dynamic Gnomon
In this exercise you will create a new plane using the on-screen dynamic gnomon. 
When creating a new plane using this method, the gnomon is initially oriented to the 
current Gview.

1 In Planes Manager, click the G column in the Iso row to return the part to 
isometric view.

2 Click Window on the View tab.
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3 Draw a box around the area of the part shown in the following illustration to 
zoom in.

4 Hover over the on-screen, dynamic 
gnomon until it glows.

5 Click and drag the gnomon to the position shown in the following illustration. 
Click to set the position. 

The Dynamic Plane dialog box opens. 

The gnomon is initially oriented to the current Iso Gview. 
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6 To change the orientation of the 
dynamic gnomon, hover over the 
blue arc until the rotational compass 
appears. 

7 Click the blue arc and rotate the 
gnomon from within the compass 
until it is at 90 degrees. Click to set 
the location. (Rotating within the 
compass snaps in angular 
increments.) 

Alternately you can enter 90.00 in 
the on-screen edit field and press 
[Enter] twice.
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8 In the Dynamic Plane dialog box, 
type DYNAMIC PLANE as the 
Name of the plane.

9 Click OK to close the Dynamic Plane 
dialog box. 
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The Cplane and Tplane axes indicate the location of the new plane origin as 
shown in the following illustration. 

10 DYNAMIC PLANE appears in the 
Planes Manager designated as the 
Cplane and Tplane.

Conclusion
Congratulations! You have completed the Introduction to Mastercam tutorial. Now 
that you have mastered the skills in this tutorial, explore Mastercam’s other features 
and functions. 

You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.
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Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 

To register, select Community, Link Account from the File tab, and follow 
the instructions.
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Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
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Attention! Updates may be available. 
Go to Mastercam.com/Support for the latest downloads.
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